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1 ROC History Editor 
The ROC History Editor allows you to insert, delete and update ROC history data. For a detailed 
explanation of the ROC History Editor User Interface, see the “User Interface” section of this 
documentation.  

For a list of tasks showing how to use the ROC History Editor see the Working with section. 

For more information on how OpenEnterprise stores ROC history data refer to the topics in the 
Conceptual section of this Reference Guide. 

 

 

2 ROC History Editor User Interface 
The ROC History Editor is available within the OpenEnterprise Desktop component. 
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There are two modes of operation - configuration and runtime. Each mode has its own separate 
User Interface.  

• Configuration User Interface 

• Runtime User Interface 

2.1 Configuration Interface 
The Configuration User interface is a multi-page dialog. The pages are opened by selecting the page 
names from the dark blue bar to the left of the dialog.  

The configuration pages are: 

� Data Service 

� Data Source 

� Data Columns 

� Report Type 

� Time Period 

� Column Format 

� Appearance 

� Settings 
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2.1.1 Data Service Page 

You use this page to set the Data Service for the ROC History Editor. This Data Service will be used 
as the single source of ROC historical data. 

 

2.1.1.1 Default Data Service  

The Data Service defined during the installation of OpenEnterprise will be selected by default.   

2.1.1.2 User Specified Data Service 

Select this option to source ROC history from a database that isn’t the default database: - 

 

For more help on defining the Data Service string click the 'Understanding' link on the banner at the 
bottom of the page.  

2.1.1.3 Test Connection 

This button enables us to test that our Data Service string was correct and that our database is 
running. A message will tell us if the attempt to connect to our Data Service was successful or not: - 
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2.1.1.4 Next button 

When you first configure a ROC History View, the configuration pages are presented as a wizard with 
[Next>>] and [<<Back] buttons.  You need to click the [Next>>] button to move to the next 
configuration page, which will be the 'Data Source Page'.  

2.1.2 Data Source Page 

The Data Source Page helps you to select a compatible data source for our ROC History Editor.  

 

2.1.2.1 Data Source Hierarchical List 

The Data Source hierarchy list displays historical data sources that are logging ROC history point 
data. These historical data streams form the root nodes, and the data sets for each stream appear as 
selectable leaves underneath. 
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2.1.2.2 Select button 

When a data set  has been selected from the Data Source list, you have to select this button before 
moving on to the next configuration page. When the button is selected, selected data set appears in 
the 'Currently selected dataset' box.  

2.1.2.3 Currently selected dataset 

 

This field is only updated with the currently selected data set when: - 

• You have selected a data set from the Data Source list 

• You have also clicked the [Select] button  

2.1.2.4 Next button 

You need to click the [Next>>] button to move to the next configuration page, which will be the 'Data 
Columns Page'.  

2.1.3 Data Columns Page 

This page enables you to map the historical data set columns to the source table columns. If you did 
not change any column names  when configuring the historical data set you can leave these set to 
their defaults. This information is used by the Editor to source historical data and apply edits to the 
database. 

 

2.1.3.1 History Column Names 

If you changed any of the suggested column names in our historical data set you need to specify the 
alternative names you used here. Any columns of the same data type found in the selected data set 
will be shown in the list boxes. We can view these other column names by selecting the down arrow 
to the right of the list boxes. 
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Note: We repeat, unless these column names were deliberately changed when the historical data set 
was configured, you do not need to change these names.  

2.1.3.2 Source Column Names 

If you changed any of the suggested column names in our source table for the data set you need to 
specify the alternative names you used here. Any columns of the same data type found in the 
selected data set will be shown in the list boxes. We can view these other column names by selecting 
the down arrow to the right of the list boxes. 

 

Note: We repeat, unless these column names were deliberately changed in the source table, you do 
not need to change these names.  

2.1.3.3 Base, Extension, Attribute Column Names (Optional) 

The ROC History Editor can use these optional columns for identifying ROC History Point objects by 
Base, Extension and Attribute names. The default names for these columns will be already selected 
in the relevant list boxes. We can leave them as they are. 

 

2.1.3.4 Next button 

We need to click the [Next>>] button to move to the next configuration page, which will be the 'Report 
Type Page'.  
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2.1.4 Report Type Page 

The Report Type Page enables you to select the type of report you want to create. Two report types 
are available; a Meter report for viewing a single entity over a period of time and a Day report for 
viewing multiple entities within a single day.  

 

2.1.4.1 Meter 

The Meter type report enables you to view the historical records for a single entity over a configured 
time period.  

When you select it the Device list box will show all configured ROC devices. You must select a single 
device for your report. 

 

2.1.4.2 Day 

The Day type report enables you to view the historical records for multiple entities for a specific day. 
You can view and edit  daily records for multiple ROC devices or a single device.  

To enable viewing of single records for all listed ROC devices you just leave the Device list box 
empty. 

The list boxes will be populated with all configured devices, access areas  and plant areas. Select the 
options required to define the devices that you want to view data for. 
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2.1.4.3 Data Type 

You can select the ROC historical data type that you require to edit from this list box. The options are: 
- 

• Daily 

• Minute 

• Periodic 

 

2.1.4.4 Report Title 

 

You can type a name for your report in here. It will appear down the left side of the report. The actual 
title displayed in the Editor will be as follows: 

1. Set via the Title alias, or 

2. Set by the Report Title field, or 

3. Set to the devicename of the Report. 

The title can contain one or more aliases e.g.  

title = <<devicename>> <<reportbase>> <<reportextension>> 

2.1.4.5 Next button 

You need to click the [Next>>] button to move to the next configuration page, which will be the 'Time 
Period Page'.  

2.1.5 Time Period Page 

The Time Period Page differs depending on the type of report selected on the Report Type Page. 
These are the options: - 

• Time Period Page (Meter Type) 

• Time Period Page (Day Type) 

2.1.5.1 Time Period Page (Meter Type) 

This page enables you to specify a period of time for which you want to view historical data. You can 
select a calendar period or a time period. 
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2.1.5.1.1 Calendar Period 

 

You can leave this option selected if a single calendar period is required for our report. The options 
are Current Hour, Previous Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, 
This Year, Last Year.  

2.1.5.1.2 Interval 

 

You can select this option if you need to specify multiple units of time such as three days, two weeks 
or three months. You need to select the number and the units of time from these controls.  

2.1.5.1.3 Offset from Midnight 

 

Report periods are by default relative to midnight (except CurrentHour and PreviousHour). The offset 
can be positive or negative and can be any time unit (minutes, hours, days, weeks, months or years). 
When adjusting the Offset from midnight, we can use the from and to times to see exactly what 
report period will be used..  

2.1.5.1.4 Timezone Adjustments 

This section enables you to control how the report period start and end time will be adjusted to 
compensate for time-zone and DST. You can opt for the following: - 

• Local - timestamps will be shown in local time with Daylight Saving Time (DST)  adjustments. 

• Local, non DST adjusted - timestamps will be shown in local time but without DST 
adjustments. 
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• UTC - timestamps will be shown in Coordinated Universal Time.   

2.1.5.1.5 If run on... 

 

This section provides you with actual details of the data that our query will produce based on the date 
and time selected. The date and time default to when the ROC History Editor was opened, but both 
can be changed by clicking on the controls. 

If you click on the date, a calendar opens out enabling you to select another date. 

 

You can click in the time field and edit the hours, minutes or seconds by typing in a new value. 

 

2.1.5.1.6 The data will be sourced... 

 

The from and to fields show you exactly the dates and times that our query will cover. If this does not 
agree with our needs you can change the query before moving on. If you want to see the UTC times 
for the query results you can check the UTC box.  

2.1.5.2 Time Period Page (Day Type) 

This page enables you to specify the actual day for which you want to view historical data.  
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2.1.5.2.1 Today 

 

You can select this option if you want to view and edit todays data.  

2.1.5.2.2 Yesterday 

 

You can select this option if you want to view and edit yesterdays data.  

2.1.5.2.3 Specific Date 

When this option is selected, the calendar control is enabled and you can select another date. 

 

2.1.5.2.4 Offset from midnight 
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The default option is to have no offset applied, so the query returns data from midnight to midnight. 
However, you can apply a negative (before midnight) or positive (after midnight) offset to our query by 
changing these controls.  

2.1.6 Column Format Page 

This page enables you to add and format the columns that will be displayed within the report. Certain 
mandatory columns will be automatically added to the list. One or more additional data columns can 
be added to define your entity or record. Each data column will map to a ROC History Point using a 
TLP or a user-defined Base/Extension/Attribute. 

 

2.1.6.1 Columns 

 

This is a list of column names for the report. By default for a Meter report, the 'Timestamp' column is 
automatically added.  
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2.1.6.1.1 Index Column 

For a Day report, both '
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Index' and 'Timestamp' columns are automatically added. 

 

The index column can be one of three selectable types: 

• Instance = Devicename + Instance e.g. “ROC1:0” 

• BaseExtension = ROC1:FLOW.01 

• UserDefined = Project Specific 

For further details on settings for the Index Column see the 'Index Type' heading below.   

2.1.6.2 Add button 

 

It is up to you to add the actual columns that you want to edit. Select this button to add a column to 
the report. The new column is added with a default name of 'NewColumn'. 

 

You can change this from the Properties form on the right of the Column Format Page.  

2.1.6.3 Remove button 

You can remove any of the columns that you have added by selecting it in the Columns list, then 
clicking this button.  
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2.1.6.4 Properties 

When you select a column from the Columns list the properties for that column are displayed. In the 
image below they are displayed by category. Each property has a name and value field.  You can edit 
the column properties directly using the value fields. 

 

2.1.6.4.1 Index Type 

When the 'Day' type of report is specified, the 'Index' column is added automatically to the displayed 
columns. The text displayed for the Index column depends on the Type selected and the expression 
in the Value field. 

 

This opens the Expression Builder dialog 

Property Name Property Value 

Type Controls the text displayed for the Index column to 
identify the record. 
Instance – the text will be formatted as 
[devicename]:[instance] where instance is the zero-based 
instance number of the record.  
BaseExtension – the text will be formatted as 
 [devicename]:[base].[extension] 
Userdefined – the text will be formatted based on the 
Value property.  

Value A string used to specify a database attribute lookup. The 
value of the attribute will be displayed in the Index 
column. 
The Value property has the format table;attribute;keys 
(separated by a semi-colon) 
table – name of table to source display data from. 
attribute – the attribute in table that will be used as the 
display value for the Index column. 
keys – the key(s) used to select the appropriate entry 
from the specified table. You can use aliases 
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devicename, reportbase and reportextension. 
E.g. the following will display the value of the description 
attribute within the custom flowgroup table. 
Value = flowgroup;description;name =<<devicename>>: 
<<reportbase>>.<<reportextension>> 

2.1.6.4.2 Appearance 

Property Name Property Value 

Alignment Text alignment in the cell. One of Default, Left, Right or 
Middle. 

Display Name The name that will be displayed in the column header. 
Format String The Format String specifies how historical values are 

formatted prior to display in the editor. 
For datetime values: 
d – short date 
D – long date 
t – short time 
T – long time 
f – full date + short time 
F – full date + full time 
g – short date + short time 
G – short date + long time 
For numerical values take the form of a type followed by a 
precision specifier. The precision specifier controls how 
many digits will follow the decimal place e.g. a value of 
1.2 with a Format String of N2 will be displayed as 1.20. 
N or n – Number "-d,ddd.ddd…” 
F or f – Fixed-point "-dddd.ddd…" 
E or e – Scientific "-d.ddd…E+ddd" or "-d.ddd…e+ddd” 

2.1.6.4.3 Data 

Property Name Property Value 

Archive Type The archive type associated with the archive point. One 
of None, Average, Accumulate, CurrentValue or Total. 
The Archive Type is ignored when the Type property is 
set to BaseExtAttribute. 

Read Only When set to TRUE, values in this column cannot be 
edited. 

2.1.6.4.4 Expression 

Property Name Property Value 

Display Expression A mathematical expression used to convert the database 
value prior to display in the Editor. The database (input) 
value is identified using the local alias <<x>>. 
E.g. the expression “<<x>>/60” will convert a database 
value stored in minutes to a display value in hours.  

Update Expression A transpose of the Display Expression. Used to convert a 
user entered value to a database value. The display 
value is identified using the local alias <<x>>. 
E.g. the expression “<<x>>*60” will convert a display 
value in hours to a database value in minutes. 
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2.1.6.4.5 Object 

Property Name Property Value 

Type Identifies whether the associated rocHistoryPoint will be 
located using a Base/Extension/Attribute or a TLP. 

BaseExtAttribute Expand to specify the Base, Extension and Attribute 
values. 

Base The Base used to identify the associated rocHistoryPoint 
entry for this column. 

Extension The Extension used to identify the associated 
rocHistoryPoint entry for this column. 

Attribute The Attribute used to identify the associated 
rocHistoryPoint entry for this column. 

TLP Expand to specify the ROC Plus and/or ROC Standard 
TLP values. 

TLP Plus The TLP used to identify the associated rocHistoryPoint 
entry for this column. For devices using the TLP Plus 
protocol. 

TLP Standard The TLP definition for a ROC Standard History Point 
parameter. For devices using the TLP Standard protocol. 

2.1.7 Appearance Page 
This page enables you to modify the appearance of the Report Editor in runtime mode. Examples of 
the default settings are displayed in the Sample column. 

 

2.1.7.1 Report Form Key 

The image below shows the areas and record types of the Report Form that will be affected by the 
styling options on the Appearance page. 
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2.1.7.2 Font 

Select any of these buttons to open the Font dialog, and then select an alternate font. 

  

2.1.7.3 Fore Color and Back Color 

Click on the color boxes to open the Color dialog, and then select a new color for the foreground or 
background. 
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2.1.8 Settings Page 

This page enables you to control which runtime functionality will be available to the user. 

 

2.1.8.1 Disable Edit 
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When checked, all modify and insert functionality is disabled. This doesn’t disable the deletion of 
historical records. Instead of the Edit  option, the user will see a View option on the Report Form 
context menu. Editing will be disabled even if the logged in user has the user security token for editing 
ROC History Editor files.  

2.1.8.2 Disable Delete 

 

When checked, all delete functionality will be disabled. Delete will be disabled even if the logged in 
user has the user security token for deleting edits.  

2.1.8.3 Display Timestamps in local time 

When checked timestamps will be displayed in local time (the default). If unchecked, timestamps will 
be displayed in UTC (as sourced from the database).  

2.1.8.4 Detect missing records 

When checked missing records will be detected and displayed (the default). If unchecked, missing 
records will not be displayed.  

2.1.8.5 Show Base Date selector 

 

When checked the Base Date selector will be displayed (the default). If unchecked, the Base Date 
selector will not be displayed.  

2.1.8.6 End-of-period timestamps 

Check End-of-period timestamps if your ROC device is configured to timestamp historical values with 
an end-of-period time. This will result in the Editor's report period being adjusted to select any records 
that fall exactly at the end of the report period. Uncheck for historical values timestamped at the start 
of the period.  

2.1.8.7 Allow incomplete records 

Allows incomplete records to be displayed even if one or more of the columns can’t be resolved to a 
ROC History Point or when no historical value exists..  

2.2 Runtime User Interface 
The Runtime User Interface is presented when the ROC History Editor is placed into runtime mode. 
This can be done in one of two ways: - 
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• If you are running the ROC History Editor within the OEDesktop Select File>Mode>Runtime 
or if running it in its own container select the Runtime menu from the menu bar at the top of 
the container. 

• You can press Ctrl and M together on the computer keyboard. When in runtime mode you 
can press the same two keys to toggle quickly back into configure mode. 

The Runtime User Interface consists of: 

1. The Meter Day Report View.  

2. The Edit Record Form 

3. The Edit Value Form 

4. The Event list. 

2.2.1 Aliases 

In runtime mode, like all OpenEnterprise Views, aliases can be passed to the ROC History Editor by 
OEMenus to affect the runtime configuration. See the Understanding page for more on Views, Aliases 
and OEMenus.  

2.2.2 Meter Day Report Form 

The Meter Day Report Form appears in the workspace view area when you select a meter in the 
Operations pane and select the Meter history option from the context menu:  

 

It enables you to view and modify daily historical records for the meter. 

Values can be edited by selecting Edit from the top of the history report, or by right clicking on a 
record and selecting Edit from the context menu. 
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2.2.2.1 Red Background 

Missing values have a red background color by default. The default background color for missing 
values can be changed on the Appearance Page of the configuration interface.  

 

2.2.2.2 Yellow Background 

Values that have been edited with the ROC History Editor have a yellow background color by default. 
 The default background color for edited values can be changed on the Appearance Page of the 
configuration interface.  

 

2.2.2.3 White Background 

Values that have not been edited with the ROC History Editor have a white background color by 
default. The default background color for unedited values can be changed on the Appearance Page of 
the configuration interface.  

 

2.2.2.4 Export 

This menu button enables you to export the Report Form in one of the three possible formats:- 

• A Comma Separated Value (CSV) file. 

• A basic Excel file (no formatting). 

• An Excel file with formatting (copies the formatting from the Report Form) 

The three file options are available on the Export As dialog:- 
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2.2.2.5 Refresh 

Refreshes the data in the form with the latest values from the database. Any pending edits are 
discarded. 

2.2.2.6 Edit 

This enables you to edit the selected record. If you do not have ‘edit’ privileges, this button will be 
renamed to View. 

2.2.2.7 Delete 

Enables you to mark a selected record for deletion. You can abort this by selecting No on the warning 
message box that appears before the deletion takes place. 

 

When a record has been marked as deleted, its status can be restored by selecting Undo Delete 
from the context menu. 
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The record is not actually deleted from the database you click Apply at the top of the Meter Day form 
or close the Meter Day form. You can close the form with the close button, shown below: 

 

2.2.2.8 Apply 

If this button is selected all pending edits or deletions will be committed to the database. 

2.2.2.9 Events 

Selecting this button will open the Event List. This contains a list of events that have occurred during 
this editing session. The events are local to this instance of the editor and are neither sourced from 
nor stored within the database.  
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2.2.2.9.1 Type Filter 

This control enables you to change the Event Type filter for the Event List. The options are:- 

• All 

• Error 

• Information 

• Warning 

2.2.2.9.2 Category Filter 

This control enables you to change the Event Category filter for the Event List. Possible values are:- 

• All 

• Configuration 

• Database 
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• History 

• SQL 

• User Control 

2.2.2.9.3 Object Filter 

This control enables you to change the Event Object filter for the Event List. Possible values are:- 

• All 

• Connection Pool 

• file 

• <Named Object> 

• Menu 

2.2.2.9.4 Event List 

Events local to the ROC History Editor are displayed here. The number of events is displayed 
immediately above the Event List.  

The list can be filtered using the drop-down filter lists at the top of the Event List.  

2.2.2.10 Base Date 

If you click on this control the Calendar appears and you can select another date for the Report. By 
default, the Base Date of the report is set to the current system date. When a new Base Date is 
selected, the displayed historical data is refreshed based on the selected Base Date. Any pending 
edits will be lost following a Base Date change.   

2.2.2.11 Edit Context Menu  

When you select a record and then right click, this context menu will appear. If the user does not have 
‘edit’ privileges, the Edit menu will be renamed to View.  

If you select Edit, the Edit Record Form will open, and you can edit the record.  

2.2.2.12 Delete Context Menu 

When you select a record and then right click, if the record actually has values (meaning it is not 
being displayed as a missing record) this context menu will appear. If you select it, you can mark the 
record as deleted.  

You can abort the deletion by selecting the [No] button on the warning message box that appears 
before it takes place. 

 



Reference Guide 
D301663X412 
APRIL 2012 ROC History Editor
 

 
- 27 - 

 

When a record has been marked as deleted, its status can be restored with the Undo Delete context 
menu which appears when it is selected. 

 

2.2.3 Edit Record Form 

This form allows you to edit a record selected from the Report form. You can view original values, 
pending updates and edited values. 

 

2.2.3.1 Edit 

When you select and right click on a value in a record marked with a status of 'Latest values' you can 
select the Edit context menu. This opens the Value Edit Form which enables you to change the 
value. 

If you are editing a missing record that was displayed in the Report Form, You can also edit the 
Timestamp value.  

2.2.3.2 Cancel 

If you select and right click on a value marked with a status of 'Pending Update' you can select the 
Cancel context menu. You can abort this action by selecting [No] from the 'Cancel Pending Edit' 
warning box that appears.  
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If you select the [Yes] button the pending edit will be removed.   

2.2.4 Value Edit Form 

This form enables you to change the selected value. The change will not be persistent until the Apply 
button is selected in the main Editor window. The Original value is the value sourced from the ROC 
device or the manually entered value initially inserted by the user. The Raw Value is the database 
value without any formatting or expression manipulation. 

 

2.2.4.1 Timestamps 

Shows the original record timestamp and the timestamp of the last update. If the value has not been 
manually edited or the record is a missing record the 'Last Updated' field will be blank.  

 

If this is a missing record, the 'Timestamp' value can be edited by selecting the Timestamp and then 
the Edit context menu on the 'Edit Record Form'. 
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Then you can update the timestamp value for the record. 

 

2.2.4.2 Value 

You can change the value by typing the new value into the 'New Value' field and then selecting the 
[OK] button. 

 

3 Working with the ROC History Editor 
This section contains a basic list of tasks that you may want to perform with the ROC History Editor. 
There is a separate list for the configuration and runtime modes of the Editor. 

• Configuration Tasks 

• Runtime Tasks 

3.1 Configuration Tasks 
This is a list of tasks regarding the Configuration of the ROC History Editor: - 

1. How to display user configured information in the Day Report Index column 

1. How to set up historization in the ROC 

2. How to configure the historical stream for use with the Editor. 
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3. How to configure the Editor 

4. How to change the Data Service 

5. How to map history and source columns 

6. How to add and configure display columns 

7. How to configure BaseExtAttribute identifiers in the database 

8. How to use Format Strings with display columns 

9. How to use display expressions 

10. How to set columns as read only 

11. How to show multiple daily records for a single Meter 

12. How to show daily records for more than one Meter 

13. How to disable editing for the Editor 

14. How to show missing records 

15. How to show incomplete records 

16. How to save the current configuration 

17. How to enable secure editing 

18. How to display user configured information in the Day Report Index column 

3.1.1 How to set up historization in the ROC 

ROC 800 RTUs contain point types called history segments which are used to record  changing data 
for trending purposes. 

History segments enable you to log data historically within the ROC. The screen below shows  ROC 
history segments displayed within ROCLINK 800. 
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The parameters of ROC Point type 113 and 114 are associated with the configuration and run values 
of orifice meters, and Point type 115 and 116 to turbine meters respectively.  

Each meter type has either 5 (turbine) or 6 (orifice, plunger or PID meter) parameters that are 
required to be logged historically. For each meter the parameters of interest are assigned to a history 
point within a history segment.  

The example screen below to shows an orifice point parameter with a TLP of 114,1, 4 selected in 
ROCLINK800 for logging in a History Segment. 

  

Below is the configuration (displayed in the ROCLINK800 application) for logging orifice meter 
parameters in the General history segment. 
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Each numbered line represents a history point, which maps to a meter run parameter. 

3.1.2 How to historize ROC history points for Editing 

I f you do not understand what historization is, see the What is historization? topic. Providing you 
have set up history segments in the ROC to historize ROC points of interest, when you add the ROC 
device to OpenEnterprise, the configured ROC history segment points will be added automatically to 
the RocHistoryPoint table in the OE database. Each row in the table is mapped to a corresponding 
ROC history segment point and is updated each time the ROC driver requests the history segment 
data from the device. However, the values in this table are transient, and are overwritten by the ROC 
driver with every request, so this table needs to be historized in OpenEnterprise. 

The instructions below contain only the most significant details necessary for historizing the 
RocHistoryPoint table for use by the ROC History Editor. Please refer to the Historian Configuration 
help file for detailed help on this process.  

1. Select Start>Programs>OpenEnterprise>Toolbox to open the Toolbox 

2. Double click on the 'Historian' icon or right click on it and select 'Configure' to open the 
Historian configuration tool. 

3. On the main page of the Historian configuration tool select Add to add a new historical logging 
group. 

4. On the first page of the wizard select the rochistorypoint table as the source table: - 
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5. On the next page (Select Fields), select the following fields from the available attributes: - 

• historytimestamp 
• historyvalue 
• historyvaluetype 
• source 
• historyvaluedeleted 

Leave the Raw data set type box selected for each attribute, but don't select any compressed 
data collection type (e.g. First, Last, Average etc.). 

 
6. On the next page (Name Fields) you can leave the Source Column and Data Access Column 

names as they are. If you change the names for the Data Access Column you will have to 
remember the names you used when configuring the Data Columns Page of the ROC History 
Editor, and select them from the column name lists. 

 

7. On the (Dataset Configuration) page set the data collection to 'Collect Data When 
Triggered'. Select the logtriggerdaily attribute as the trigger for data collection. 

 

3.1.3 How to historize ROC history points for Backfill 

If you do not understand what historization is, see the What is historization? topic. Providing you have 
set up history segments in the ROC to historize ROC points of interest, when you add the ROC 
device to OpenEnterprise, the configured ROC history segment points will be added automatically to 
the RocHistoryPoint table in the OE database. 
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However, the functionality on this table is used for editing ROC history point data with the ROC 
History Editor. If you want to use the same data for trending or reports, you need to use historical 
backfill (see the What is historical backfill? topic). This functionality is only set up on tables that are 
derived from the OpenEnterprise Signal table. So first, you need to create OpenEnterprise signals for 
each ROC history point (see the How to enable historical backfill for ROC historized data topic). Then 
you need to historize this data. 

The instructions below contain only the most significant details necessary for historizing the 
RocRealAnalog table for trending and reports. If you have some ROC history points that are digital 
signals, then you will need to do this for the RocDigital table. Please refer to the Historian 
Configuration help file for detailed help on this process.  

1. Select Start>Programs>OpenEnterprise>Toolbox to open the Toolbox 

2. Double click on the 'Historian' icon or right click on it and select 'Configure' to open the 
Historian configuration tool. 

3. On the main page of the Historian configuration tool select Add to add a new historical logging 
group. 

4. On the first page of the wizard select the rocrealanalog table as the source table: - 

 

5. On the next page (Select Fields), select the following fields from the available attributes as a 
minimum: - 

• logtime 
• logvalue 

It is important for trending that you select the Indexed option for the logtime column: 

 
Leave the Raw data set type box selected for the logvalue column, but don't select any 
compressed data collection type (e.g. First, Last, Average etc.): 
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6. On the next page (Name Fields) you can leave the Source Column and Data Access Column 

names as they are. If you change the names for the Data Access Column you will have to 
remember the names you used when configuring the Data Columns Page of the ROC History 
Editor, and select them from the column name lists. 

7. On the (Dataset Configuration) page set the data collection to 'Collect Data When 
Triggered'. Select the logtrigger column as the trigger for data collection. 

 

3.1.4 How to enable historical backfill for ROC History Points 

Historical backfill enables you to retrieve historical data from the ROC device that you may have 
missed during a break in communications. To set this up you need to: 

1. Set up historization in the ROC. See the How to set up historization in the ROC topic for 
instructions. 

2. Create OpenEnterprise signals for the historized segment points in the ROC. 
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3. Ensure that the ROC signal tables (either ROCRealAnalog or ROCDigital) into which these 
signals are added are historized (i.e. the signals just added will be logged by the OE historian 
to a historical data stream). If you are unsure, open the Historian Configuration Tool from the 
toolbox, and check if one of the logging groups configured is sourced from the relevant ROC 
signal table, and that it is a non-user enabled stream (i.e. it logs all objects in the source 
table). If there is not an appropriate historical stream configured, then add one (user enabled 
or not). See the Historian Configuration Tool documentation (HistorianConfigurationTool.pdf) 
for details) 

4. On the ROC Driver Configuration screen check the Default Device Flag that says "Update 
Database History Point with ROC Current Values". 

 

3.1.5 How to add the Editor window to the OEDesktop 

1. From the OEDesktop menu select Desktop>New 

2. From the New dialog select the ROC History Editor type. Then select the [OK] button. 
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3.1.6 How to configure the Editor 

For help on determining the best options for your particular system, you should refer to the 
Configuration Interface topic.  

1. Place the ROC History Editor into Configuration mode. 

2. Right click on the ROC History Editor and select the Properties context menu. 

3. To configure the ROC History Editor you will have to keep selecting the [Next] button on each 
page of the configuration wizard until it changes to a [Finish] button on the last page. 

4. Specify the data service you are connecting to on the Data Service page. For further help see 
the Data Service Page topic. 

5. Specify the historical data source on the Data Source page. For further help see the Data 
Source Page topic. 

6. Confirm the mapping of historical columns to source table columns on the Data Columns 
page. For further help see the Data Columns Page topic. 

7. Specify the report type on the Report Type page. For further help see the Report Type Page 
topic. 

8. Specify the time period on the Time Period page. For further help see the Time Period Page 
topics. 

9. Add and configure the columns you need to display in your report on the Column Format 
page. For further help see the Column Format Page topic. 

10. You may optionally change the appearance of records on the Report Form using the 
Appearance page. For further help see the Appearance Page topic. 

11. You may wish to set local options for the ROC History Editor on the Settings page. For further 
help see the Settings Page topic. 

3.1.7 How to change the Data Service 

1. On the Data Service page of the configuration wizard, select the User specified Dataservice 
button. 
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2. Type in the Data Service that you are connecting to. 

3.1.8 How to map history and source columns 

1. Place the Editor into Configure mode. 

2. Move through the wizard if the file has not been configured yet until you get to the Data 
Columns page 

3. If the file has already been configured select the Data Columns page from the navigation 
pane on the left 

4. If you have used different names for the history columns than the defaults, select the names 
used from the drop-down  lists. 

 

3.1.9 How to add and configure display columns 

See the Column Format Page for details on the configuration involved in these steps.  

1. Place the Editor into Configure mode. 

2. Move through the wizard if the file has not been configured yet until you get to the  Column 
Format page. 

3. If the file has already been configured select the Column Format page from the navigation 
pane on the left. 

4. Click the [Add] button under the Columns list: - 

 

5. The new column is added to the Columns list with a default name: - 

 

6. Use the Properties box to modify the new column's properties as necessary  : -  

a. Column Name 

b. Archive Type 

c. Display Expression 

d. Update Expression 
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e. Type 

f. BaseExtAttribute 

g. TLP  

3.1.10 How to Configure BaseExtAttribute identifiers in the database 

Base Extension Attribute identifiers can be used instead of the TLP definition to map a column on 
your Report form to an entry in the ROC History Point table. 

The BaseExtAttribute identifier is more useful if you want to use aliases to cut down the amount of 
ROC History Editor files that you need to create. ROC History Segment configuration may differ 
betyouen ROCs on the same network so configuring Editor columns to address TLPs may not be 
suitable for creating a History Editor configuration that can be used for all devices. Hoyouver, the 
BaseExtAttribute values can be set to be the same for all devices. This allows you to use the 
Devicename alias to distinguish the actual value that you want to appear in the ROC History Editor 
Report form.  

Let's say you want to view the 'Time' parameter in the Report form of your ROC History Editor, and 
you want to use the same file to view this value for different ROC devices. 

As you can see, the historylogpoint (TLP) value for the same parameter type in each of the devices 
on your system is different: - 

  

However, you can set the reportbase, reportextension and reportattribute values for each device to 
the same values, and then refer to a unique value by using the devicename as the determining factor: 
- 

 

Note - you have to insert these values into the database yourself. It is important also to use a 
numerical value for the 'reportextension' attribute, otherwise this will not work. (The Editor will 
use the numerical reportextension to locate multiple entities in the same device. It’s treated identically 
to the Logical in a TLP). 

Then, instead of using the TLP definition for the Time object parameter in the RocHistoryPoint table, 
you can use the Base, Extension, Attribute definition format: - 

 

These values can theoretically be the same for different devices, so you can use the 'Devicename' 
attribute to call the same file to view the Time value for different devices. 
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3.1.11 How to use Format Strings with display columns 

This is documented under the Appearance heading in the Column Format Page topic.   

3.1.12 How to use display expressions 

Mathematical expressions can be used to convert the database value prior to display in the Editor or 
to convert a user entered value to a database value.  

For an example see the Expression heading in the Column Format Page topic.   

Below is a list of expressions available. 

• Functions  

• abs  

• acos  

• asin  

• atan  

• cos  

• cosh  

• floor  

• ln  

• log  

• sign  

• sin  

• sinh  

• sqrt  

• tan  

• tanh  

• Operators: +, -, *, /, ^, !  

• Constants: Pi  

3.1.13 How to set columns as read only 

This is documented under the Data heading in the Column Format Page topic.   

3.1.14 How to show multiple daily records for a single Meter 

1. On the Report Type Page of the ROC History Editor wizard select the Meter option. 

2. On the Time Period Page select a Calendar Period or an Interval that is a multiple of the ROC 
Data Type that was selected on the Report Type Page. 

3.1.15 How to show daily records for more than one Meter 

1. On the Report Type Page of the ROC History Editor wizard select the Day option. 

2. Do not select a Device from the Device list in the Day section. 
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3.1.16 How to disable editing for the Editor 

Check the Disable Edit box on the Settings Page of the ROC History Editor configuration wizard. 

3.1.17 How to show missing records 

Check the Detect Missing Records box on the Settings Page of the ROC History Editor configuration 
wizard. 

3.1.18 How to show incomplete records 

Check the Allow incomplete records box on the Settings Page of the ROC History Editor configuration 
wizard. 

3.1.19 How to save the current configuration 

1. Put the ROC History Editor into configure mode. 

2. Configure the Property pages. 

3. Select File>Save As from the OEDesktop menu bar and save the file to the destination of 
your choice. 

3.1.20 How to enable secure editing 

For User Groups that are allowed to edit the ROC History: - 

1. Open the Security Configuration Tool from the Toolbox. 

2. Open the Property pages for the appropriate User Group. 

3. Select the Token Group tab. 

4. Move the ROC History Editor Token Group into the Include list for that User Group. 

5. For any users belonging to that User Group who should not edit the ROC History Editor, place 
the appropriate Application Token in that user's Exclude list. 

For User Groups that are not allowed to edit the ROC History Editor: - 

1. Select the Properties for each of these User Groups and select the Application Token tab. 
Ensure that they do not have any of the Application Tokens for the ROC History Editor in their 
Include List. 

2. Select the Token Group tab for these User Groups. Ensure that these User Groups do not 
have the Token Group for the ROC History Editor in the Include list on that tab. 

3. For any users belonging to that User Group who may be allowed to edit the ROC History , 
place the appropriate Application Token in that user's Include list. 

3.1.21 How to display user configured information in the Day Report Index 
column 

This is documented under the Index Type heading in the Column Format Page topic.   

3.2 Runtime Tasks 
This is a list of tasks regarding the Runtime operation of the ROC History Editor: - 

1. How to edit a history value. 
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2. How to cancel pending Edits. 

3. How to apply a history value change to the database. 

4. How to insert a record. 

5. How to delete a history record. 

6. How to undelete a history record. 

7. How to view Roc History Editor transactional Events. 

8. How to change the date for the Report form. 

9. How to save the contents of the Report form as a file. 

10. How to use aliases to the ROC History Editor 

11. How to track ROC History editing 

3.2.1 How to edit a historical value 

1. You need to select a row with a value that you want to edit from the ROC History Editor 
Report window and right click.  Then Select the 'Edit' option from the context menu. 

 

2. In the Edit Record form that now appears you can now select the individual value that you 
want to edit from the 'Latest values' row. After a right click with the mouse you select the 'Edit' 
option from the context menu once more. 

 

3. In the 'New Value' text box on the 'Edit Value' form you need to enter the new value. Then 
click the [OK] button. 
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4. The new value is shown separately as a new record with a green background. Click the [OK] 
button to go back to the Report Form. 

 

4. The new value will appear in the Report Form with a green background to indicate that it is a 
Pending Update. In this state, the update has not  yet been committed to the database. 

 

5. To commit your change to the database you need to select the [Apply] button on the bar 
along the top of the Report Form. 
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6. The background of the edited value changes color to indicate that the change has been 
committed to the database. 

 

3.2.2 How to cancel a pending edit 

1. To cancel a Pending Edit from the Edit Record form you can select the Cancel option that 
appears when you right click on the edited value on the Pending Edit row. 

 

2. You need to select [Yes] when the Cancel Pending Edit message appears if you want to 
cancel the Pending Edit. If you select [No], the Pending Edit will remain. 
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3.2.3 How to apply an edit to the database 

Click the [Apply] button from the button bar at the top of the ROC History Edit Report form. 

 

3.2.4 How to insert a new record 

You can insert new records where there are missing records.  This is how an empty record looks in 
the Report form: - 

 

See the 'How to show missing records'  topic on how to show missing records. 

1.  Firstly you need to select the empty record, right click and then select the Edit option on the 
context menu. 

 

2. On the Edit Form, you can now select the Edit option for each value in the empty record that 
 you want to change.  
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3. You can also change the Timestamp when inserting new records. 

 

3.2.5 How to delete a record 

1. To delete a record, you just select the record you want to delete, right click and select the 
delete option from the context menu. 

 

2. A message appears, asking you to confirm the deletion. You can confirm the deletion by 
selecting the [Yes] button or abort it by selecting the [No] button. 

 

3. At this stage, the deletion is not yet committed to the database. It is a pending delete. To 
commit the deletion to the database you have to select the [Apply] button from the top of the 
Report form. A deleted record that has not been committed to the database is displayed with 
a red background and a line through the values. 

 

4. A deletion that has been committed to the database by selecting the [Apply] button from the 
top of the Report form is shown as a missing record. The 'Undo Delete' option is now not 
available on the record. However, you can still edit the record. 
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3.2.6 How to undelete a record 

If you have not committed a deletion to the database, you can undelete it from the Report form by 
selecting the 'Undo Delete' option. 

 

3.2.7 How to view ROC History Editor events 

1. To view the Event list, click the [Events] button at the top of the Report form. 

 

2. You can then view the Events list. 
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3.2.8 How to change the report base date 

1. To change the report base date, you just click the button to the right of the date at the top of 
the Report form and select a new date. 
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2. If you have  made changes that are not committed to the database, you will see this 
message.  

 

If you select [Yes] the base date for the report is changed, but you will lose any edits not 
committed to the database. 

3.2.9 How to save the report form as a file 

1. Select the [Export] button from the top of the . 

 

2. The Export As dialog appears. You can type a name for the file in the File name field. 

 

3. You can select any of three file types to export to from the Save as type list 
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• CSV = Comma Separated Values file 

• Excel Basic = An Excel file with no formatting styles 

• Excel with Styles = An Excel file with the same styles that are used in the Report form 

3.2.10 How to use aliases with the ROC History Editor 

Aliases can be passed to the ROC History Editor from OEMenus to affect the runtime configuration. 
The following aliases are supported: - 

• Devicename 

• Instance (Logical) 

• BaseDate 

• Accessarea (Day report only) 

• Plantarea (Day report only) 

• Title 

• ReportBase and ReportExtension 

3.2.10.1 A Custom OEDesktop Menu 

This example shows how to send the Devicename alias to the ROC History Editor via a custom 
OEDesktop menu. 

1. From the OEDesktop menu bar you need to select Desktop>Customize... 

2. On the Menu tab you select the [New] button and give the new custom menu a name. 

 

3. You then click the [Configure] button on the New Menu Item dialog to open the Menu Editor 
dialog for configuration. 

4. Now you can create a menu for each of the ROC Devices available. 
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The new OEDesktop menu will look like this: - 

 

5. Now you can configure these menus. You will start by selecting the first menu item, which in 
this example is 'FloBoss107'. 

6. Then you select the 'ROC History Editor' as the target from the Target list. 

 

7. Next you select 'Load File with Parameters' from the Action list. 

 

8. Next you select the [Configure] button. 
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9. Now find the ROC History Editor file that you will be opening by selecting the browse button to 
the right of the File text box on the Configuration dialog. The file name and path will be 
entered into the relevant fields. 

 

10. Now enter the Target Column name and the value that you want to give it. Finally click the 
[Add] button. 

 

11. The Parameter list should be updated with the Name and Definition value of the alias. 

 

12. Click the [OK] button at the bottom of the 'Load file with parameters' dialog. Then configure 
the other menu items accordingly. Now when the user selects any of the options from the 
'Edit History Values' menu on the OEDesktop menu bar, the ROC History Editor file will be 
opened, and the Devicename selected by the user will be passed to it as a parameter. 
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3.2.11 How to track ROC History Editing 

All changes to historical data made through the Editor are journalled to the OpenEnterprise Event 
History table. The event message will detail the devicename, source table object, username and 
change details.  

Events can be viewed by the OpenEnterprise Event Viewer or within the SQL Client. 

3.2.11.1 What was done? 

The eventhistory.description attribute explains the changes that have been done. E.g  

• An update - '06-JUL-2009 01:00:00 Diff updated to 32' 

• A delete -  '06-JUL-2009 01:00:00 record deleted' 

• An insert is a series of updates for the same object - 

 '06-JUL-2009 01:00:00 Volume updated to 70' 

'06-JUL-2009 01:00:00 Static updated to 120'  

'06-JUL-2009 01:00:00 Time updated to 1380' 

'06-JUL-2009 01:00:00 Diff updated to 33'  

3.2.11.2 Who did it? 

This information can be found in the eventhistory.username attribute. 

3.2.11.3 What object was updated? 

This is found in the eventhistory.objectname attribute. 
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3.2.11.4 What device did the object belong to? 

This is found in the eventhistory.devicename attribute. 

3.2.11.5 When did the event take place? 

This information is found in the eventhistory.occurencetime attribute. 

4 ROC History Editor Concepts 
The topics in this chapter provide conceptual information about the ROC History Editor which is 
intended to help you understand what it does.  

1. What is the ROC History Editor? 

2. What is a View in OpenEnterprise? 

3. What is historical data? 

4. What is a historical stream? 

5. What is historical backfill? 

6. What is the Data Service? 

7. What is the ROC History Editor Data Source? 

8. What is a Data Set? 

9. Where is ROC History data stored? 

10. ROC history segments and the rocHistoryPoint table 

11. What is TLP nomenclature? 

12. What are the reportbase, reportextension and reportattribute columns? 

13. What is the ‘source’ column used for? 

14. What is the Default directory for saved Roc Historical Editor files?  

15. What is the default directory for exported Report Forms? 

16. What is an Alias? 

17. What is OEMenus? 

18. What Aliases are supported by the ROC History Editor? 

19. What are spit records? 

20. What happens to deleted records? 

4.1 What is the ROC History Editor 
The ROC History Editor is an OpenEnterprise View component that allows you to insert, delete and 
update ROC history point data.  

The source table used by the ROC History Editor is the historical data set used to log data from the 
RocHistoryPoint table.  
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Since this could be different for each configured system, you have to select this while in Configuration 
mode from the Data Source page.  

4.2 What is a View in OpenEnterprise? 
In the context of OpenEnterprise SingleStation, a View is a control that displays OpenEnterprise data.  

They are either clients of the OpenEnterprise database or of the OpenEnterprise data access or 
historical data access OPC Servers.  

OpenEnterprise Views open in the Workspace view area of the Desktop. They are: - 

4.2.1 Database Clients (tabular data) 

• Alarm/Event MultiGrid View 

• MultiGrid Query View 

• ROC History Editor 

4.2.2 OPC Clients (OPC tag data) 

• App View (mimics) 

• Trend View 

4.2.3 View Data 

Depending on their type, Views have different ways of retrieving the data they display: - 

• Tabular Views - these are MultiGrid type views, and display data resulting from an 
OpenEnterprise SQL query. Queries may be managed by the MultiGrid itself (RTU Stats) or 
by an OpenEnterprise control embedded into the MultiGrid (Alarm and ROC History Editor 
views).  

• OPC Views - These display data derived from OpenEnterprise object queries. The queries 
are requested from the OpenEnterprise OPC Server in the form of OPC 'tags', and are 
associated with dynamic graphical objects. OpenEnterprise OPC tags are inserted into Data 
Source fields from the OpenEnterprise tag browser. Examples are the App and Trend views. 

4.3 ROC History Point Logging 
This diagram shows how OpenEnterprise logs ROC history point data. The ROC driver by default logs 
ROC history points to the RocHistoryPoint table. You need to historize this data by creating a 
historical logging stream using the Historian Configuration tool from the OE toolbox. You can then edit 
the historized data with the ROC History Editor.  

The ROC driver can also be configured to log the same ROC history points to the normal 
OpenEnterprise signal tables, which again you must historize. You can then take advantage of 
historical backfill capability, which enables you to use the data in trends and reports. 
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4.4 What is historical data? 
Historical data is a table that records values for data that is constantly changing in real time. Each 
record in the table is a snapshot of the value at the time when the data was logged. The data can be 
logged at regular intervals or when a designated attribute within the source table is updated. 

The logged data can be "raw" or "compressed". "Raw" data is the actual value that was logged at a 
specific time. "Compressed" data is "raw" data that has been processed mathematically to obtain 
statistical information, such as the average, highest or lowest value for a particular signal over a 
longer time period. 

Historical data is logged in OpenEnterprise by a software module called the historian. In order to log 
and edit historical values created by ROC History Points (which belong to ROC history segments), the 
historian must be set up to log when the "LogTrigger" attribute is updated in the RocHistoryPoint 
table.  See the 'How to configure the historical stream' topic for instructions on how to do this. 

4.5 What is historization? 
Historization is the process of taking values that are being constantly overwritten to reflect changes in 
the field or plant  and recording each update in a separate table so that there is an ongoing record of 
the updates. There are two ways of logging this historical data: 

� At regular intervals of time 

� When an attribute changes value 

For utilizing historical backfill, the historical data must be logged when the logtrigger attribute is 
updated. For more information on historical backfill, see the What is historical backfill topic 
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4.6 Historization and the ROC History Editor 
The ROC History Editor displays and enables you to modify data that has been historized from the 
RocHistoryPoint table.  

The ROC driver updates the values in the RocHistoryPoint table, updating the "historyvalue", 
"historytimestamp", "logtrigger", "source" and "historyvaluetype" fields. It updates the "source" field to 
0 (zero) to indicate that it was the ROC driver that updated the row. It also adds 1 to the value of the 
"logtrigger" field.  

When a user adds, modifies or deletes a row using the ROC History Editor, the ROC History Editor 
updates the "historyvalue", "historytimestamp", "logtrigger" and "historyvaluetype" fields in the 
RocHistoryPoint table. It also sets the "source" field to 1, indicating that this was a manual update. 

Whether the ROC driver or the History Editor updates the RocHistoryTable, when the "logtrigger" 
attribute is updated, the OE historian logs the new values to the relevant historical stream (log file) 
which is also entered into the corresponding historical data table. 

4.7 What is a Data Stream? 
A data stream defines all of the data that will be collected and stored by the historian in a historical 
logging group. It defines the source table, columns to log, the data sets and objects to log.  

4.8 What is historical backfill? 
Historical backfill is the ability of OpenEnterprise to retrieve historical data from the RTU after a break 
in communications. 

Historical backfill is essential for SCADA applications that cannot guarantee 100% continuous 
communications. With ROC RTUs only a little extra configuration is required to enable historical 
backfill. 

See the "How to enable historical backfill for ROC devices" topic for more information. 

4.9 What is the Data Service? 
The ROC History Editor data service is a TCP/IP socket that points to the OpenEnterprise database. 
This is the database that is sourcing the data for the ROC History Editor.  

An OpenEnterprise data service is defined by an IP address and port number. Both IP address and 
port number are usually defined by aliases set up in the Windows Host and Services files 
respectively.  

The data service can be expressed in three ways, depending on the Server setup and the client's (the 
ROC History Editor's) relationship to it: - 

1. Local = 'rtrdb1' - the client is on the same PC as the OpenEnterprise database, which is 
running as a standalone database, and the client is connecting directly to the database 
process via the 'rtrdb1' port. 

2. IP - Standalone = 'RemoteServer:rtrdb1' - the client is connecting to the 'rtrdb1' port via the 
network. The client may be either on a different PC to the OpenEnterprise database, or on the 
same PC.  

3. IP - Redundant = 'RemoteServer1:rtrdb1,RemoteServer2:rtrdb1' - the client can connect to 
the 'rtrdb1' port on either of the redundant servers via the network. By default it will connect to 
the active Master server, but it can also be connected to the Standby by use of the (ro) 
argument following the data service string (e.g. Server1:rtrdb1,Server2:rtrdb1 [ro]). 
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4.10 What is the ROC History Editor Data Source? 
The ROC History Editor' s data source is the historical data set that logs values from the 
RocHistoryPoint table. See the 'How to configure the historical stream' topic for instructions on how to 
do this. 

The ROCHistoryPoint table is the source table for this historical data set. It holds data collected by the 
ROC RDI from the configured ROC history points in the device.  

Database Command Language (CL) scripting updates the 'logtrigger' attribute when any of the logged 
columns changes value. This causes the Historian to take a historical sample of that row for the 
historical data set. 

4.11 What is a Data Set? 
A data set defines a unique file containing historical data. It is maintained by the Historian.  

An OpenEnterprise data set can contain raw data (meaning current values at sample time) or 
compressed data (meaning a value arrived at by applying a mathematical formula to a block of raw 
values), but for the ROC History Editor, the only type is raw data, because all 'compression' is done in 
the ROC device. See the 'How to configure the historical stream' topic for instructions on how to 
configure this. 

The data set is output to a .log file which is viewable as a table using the Database Explorer or the 
SQL client. The name of the table begins with 'raw' and ends with the unique number given to the 
historical logging group to which it belongs. 

4.12 Where is ROC History data stored? 
In the first instance, the ROC device must be configured to historically log meter run values within 
history segments. Then the ROC device is then added using the ROC Configuration tool. 

The ROC driver is then scheduled to collect history segment data. The ROC driver deposits daily 
ROC History segment values (i.e. meter run values) and times in the "rochistorypoint" table.  The 
ROC driver updates the historyvalue and historytimestamp fields for each point in the rochistorypoint 
table, and updates the relevant logtrigger field (e.g. logtriggerdaily). 

The update of the logtrigger field causes the Historian to log each updated value to a log file which is 
displayed in the database as a historical data table. This action historizes the changing contents of 
the rochistorypoint table. 

Historical data tables can be queried and used by various clients. In OpenEnterprise historical data 
can be viewed in the Trend View, the SQL View or the ROC History Editor View. However, the ROC 
History Editor is a client that allows you to not only view the ROC History Point historical data, but to 
make controlled modifications to it.  

You don't need to create or maintain the log files. That is done by the Historian. How does Historian 
know what log files to create and what values to store in the log files? This is done through a set of 
tables. The main ones are:- 

• Logcontrol table - tells the Historian the source table to use 

• Logcolumn table - tells the Historian what columns from the source table to collect 

• Logdata table - tells the Historian what log files to create and when to collect the data 

You don't need to worry about these tables because you can configure a logging group using the 
Historian configuration tool. If you do want to find out more about the tables that are used by the 
Historian to configure historical logging groups, then see the OESchema Reference documentation. 



Reference Guide 
D301663X412 
APRIL 2012 ROC History Editor
 

 
- 59 - 

 

If you want to see the how we configured the ROC History Point logging group which we used as an 
example in this document, see the 'How to configure the historical stream' topic. 

4.13 How is ROC History data stored? 
ROC History data is stored by the OpenEnterprise Historian. It logs designated values from the 
RocHistoryPoint table when the 'logtrigger' attribute changes value. 

4.14 ROC History segments and the rochistorypoint table 
The RocHistoryPoint table stores ROC Historical Segment values. ROC History Segments are added 
to the RocHistoryPoint table by the ROC Configuration Tool. This is how they appear in the 
configuration tool: - 

 

This is how they appear in the RocHistoryPoint table: - 

 

Each row in the above table represents an individual Roc History Segment Parameter.  

4.15 What is TLP nomenclature? 
TLP stands for Type number, Logical number, Parameter number. It is a way of referring to a single 
ROC parameter by referring to: - 
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• The ROC Point Type as a number 

• The Logical number of the ROC Point Type in the device 

• The Parameter number within the Point 

The usual method of expressing a ROC parameter with TLP is to separate each number with a 
comma: - 

'<Type Number>,<Logical Number>,<Parameter Number>' - e.g. '42,0,6' 

This is shown here in the 'historylogpoint' attribute of the RocHistoryPoint table: - 

 

4.16 What are the reportbase, reportextension and reportattribute 
columns? 

These columns can be used to identify the values to display on the Report form of the ROC History 
Editor. Here is an example set up from the 'Column Format' configuration page.  

 

The other way to identify parameter values is to use the TLP recognition string found in the 
'historylogpoint' attribute. Here is an example from the same 'Column Format' configuration page: - 

 

This TLP method of identifying the objects displayed on the Report form can have drawbacks if you 
want to re-use ROC History Editor files by using the 'Devicename' alias with OEMenus to call the 
saved file. 
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If you use the TLP recognition method you find that values set up in the ROC Editor file do not match 
for different devices because each TLP value is by definition completely unique. 

However, if you use the reportbase, reportextension and reportattribute to define your objects, you 
can use the same identifiers for the same type of objects in different devices when setting up your 
report. Then you can use the 'Devicename' alias to view the same object type in another device. 

For an example of how to create reportbase, reportextension and reportattribute values in the 
database see the 'How to configure BaseExtAttribute identifiers in the database' topic. 

4.17 What is the source column used for? 
The data set used for logging values from the RocHistoryPoint table has a column named 'Source'.  

This column indicates where the current history value originated. A value of 0 (zero) indicates the 
RTU and a value of 1 (one) indicates a value entered by the ROC History Editor. 

4.18 What is the default directory for saved ROC History Editor 
files? 

The default directory for saving ROC History Editor files is 'O:\History'. 

4.19 What is the default directory for exported report forms? 
The default directory for exported Report forms is the current user's 'My Documents\Bristol\Output' 
folder. 

4.20 What is an Alias? 
An alias is a variable associated with an OpenEnterprise View that can be resolved in runtime. An 
alias will typically have a value from a parameter passed through the OEMenus message bus when 
the View is opened. Aliases primarily enable reuse of OpenEnterprise Views. 

Broadly speaking, aliases for Views that use the OpenEnterprise OPC server for displaying data can 
be defined within OPC tags by the user. Aliases for Views that display tabular data obtained directly 
from the database are defined within the View itself and represent attributes within the source table 
used by the View. 

4.21 What is OEMenus? 
OEMenus is a sub-system used by the Views to create a context menu on any View (known as the 
Source View) that can open and pass parameters to other Views (the Target View). Passed 
parameters can also be based on user selections made on the Source View. 

This not only provides navigation for the operator of a configured SCADA system, but also aids in the 
re-use of Views, reducing the number of View files required for the specific system. 

4.22 What Aliases are supported by the ROC History Editor? 
The aliases supported by the ROC History Editor are: - 

• Devicename 

• Instance (Logical) 

• BaseDate and BaseTime 

• Accessarea (Day report only) 
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• Plantarea (Day report only) 

For an example of using aliases, see the topic entitled 'How to use aliases with the ROC History 
Editor'. 

4.23 What are split records? 
The ROC 800 can be manually forced to create an end of day record for a history segment at any 
time. This does not stop the normal end of day record being created for the history segment, so for a 
single day there may be more than one record. This is known as a split record. 

This is handled by the ROC History Editor. The split records will be shown in the Report Form with the 
correct timestamp. They are edited in the same way as normal records. 

4.24 What happens to deleted records? 
No historical data is actually deleted when a historical record is deleted.  

Following the delete of a record, the value of historyValueDeleted for all historical values for that 
record will be updated to TRUE.  

This will hide the values within the Editor but the values can still be viewed using other 
OpenEnterprise clients (Reporting, SQLC). 
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